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Advanced Asset Submission

This procedure is performed in the Asset Editor. (Access to the Asset Editor is determined 
by the role to which the user is assigned.)

1.  Open the File menu in the Asset Editor.

2.  Select New

The Create a New Asset pop-up opens.
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3.  Enter the appropriate information in the Name and Version text boxes.

4.  Select the appropriate Type template from the drop-down.

5.  Click OK.

The new asset appears in the Asset Editor.
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6.  Click Save in the File menu in the Asset Editor.

The asset is submitted for review and registration.
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The Registration Process

Assets determined to be appropriate for reuse are submitted to the repository. Submitted 
assets are reviewed by the registrar, who determines which assets will proceed through the 
registration process.

Assets accepted by the registrar enter the registration work queues. The submitter can track 
the asset's progress toward registration using the My Submissions folder on the My Stuff 
page. Submitters are notified about rejected assets and the reason for rejection (for 
instance, a duplicate asset).

Understanding the Registration Process

Assets moving through the registration process are organized and managed via several 
folders, as displayed in the file tree in the Asset Editor.
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An asset begins the registration process in the Pending Review folder, under the 
Submitted folder. Once accepted or rejected by the registrar, the asset moves to the Under 
Review folder, under Submitted.

Pending registrar review and approval of the data on the tabs in the Asset Editor, the asset 
moves from Under Review to the Registered folder. Users can track the progress of assets 
by using the Search function, which accesses Submitted, Unsubmitted, and Registered 
assets, or by using My Stuff.

The registration process includes the following actions:

●     Submission
❍     An asset is submitted by a user and appears in the Pending Review folder 

under Submitted. An automatic email message alerts the registrar that a new 
asset has entered the submission queue.

●     Review
❍     The registrar examines the asset and its associated information and makes a 

decision to enter it into the work queues or to reject it.

●     Rejection
❍     If the asset is rejected, the registrar enters a reason for the rejection.

❍     When an asset is rejected from the submission folder, it is removed from the 
Asset Editor and marked as rejected in the submitter's My Submissions 
folder in My Stuff.

●     Acceptance
❍     Assets accepted for registration move to the Under Review folder, and the 

registrar or advanced submitter begins the registration process. The required 
information is gathered and entered on the appropriate tabs in the Asset 
Editor. The registrar examines each tab and monitors the workflow. When 
information for a specific stage of the workflow is acceptable, the registrar 
approves the data on the appropriate tab. There is no prescribed order in the 
approval process; the registrar can approve any stage in any order. The 
registrar also has the option to edit any of the information for any stage of the 
process.

●     Approval
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❍     The registrar grants final approval on the Administration tab, based on 
organizational standards regarding the information supplied on each of the 
various tabs. The specific configuration of Asset Editor tabs for any asset is 
determined by the Type template to which the asset is assigned on submission. 
Each tab provides various elements for metadata that is used to describe the 
asset and facilitate its use.

Accepting a Submission

This procedure is performed in the Asset Editor. (Requires appropriate permission.)

1.  Open the Submitted folder.

2.  Open Pending Review.

3.  Select the asset to be registered.

4.  Options:

❍     Click Accept.
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The asset moves to the Under Review folder in the tree, and also appears in 
each of the workflow folders under the asset. The workflow folders correspond 
to tabs in the Asset Editor.

❍     Click Accept and Assign

The Assigning Users popup opens.

1.  Use the << and >> buttons to move items between the Available Users 
and Selected Users columns.

2.  Click OK

The asset moves to the Under Review folder in the tree and is assigned 
to the selected user/users, who will provide the information required for 
each of the tabs in the Asset Editor. The assignees also may receive a 
notification e-mail that lets them know they are assigned to this asset.

Registering an Asset

Overview Tab

1.  Click the Overview tab.
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2.  Enter the appropriate information in each of the fields.

3.  Click Approve.

The text in the Overview tab changes color and the Approve button changes to 
Unapprove.

❍     Note: Approval buttons in the Asset Editor are visible only to users with the 
appropriate permissions.
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Taxonomy Tab

1.  Click the Taxonomy tab.

Several Categorizations are displayed.

2.  Click the Assign button in the Classification section.

The Assign Classifications pop-up opens.
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3.  Use the radio buttons to select the appropriate classification.

❍     Raw
■     No assurance of quality or completeness.

❍     Educational
■     For educational/informational purposes only. Not approved for use in 

projects.

❍     Approved
■     Approved by the Registrar for use in projects.

❍     Recommended
■     Approved and successfully deployed in at least one project.

❍     Mandated
■     Must be used whenever a project requires the functionality the asset 

provides. (This is especially relevant for Web services that access 
customer data, process payments, etc.).
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4.  Click OK.

The selections are listed in the Classifications section.

Note: Default Categories may be customized to reflect your environment.

5.  Repeat the process for each section in the Taxonomy tab.

6.  Enter an appropriate keyword in the text box in the Keywords section.

7.  Click Add.

The new keyword appears in the Keywords list.

Add other keywords as necessary.

8.  When the Taxonomy tab is completed, click Approve.

The text in the Overview tab changes color and the Approve button changes to 
Unapprove.
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Documentation Tab

1.  Click the Documentation tab.

A number of suggested document titles are listed in the Documentation window. 
Appropriate documentation may be associated with each of these titles, and new 
documents may be added to the list.

To add a new document:

2.  Click Add.

The Edit pop-up opens.
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3.  Enter the appropriate information in the Name text box.

4.  Click the Edit button next to the URL text box.

The Edit URL pop-up opens.

5.  Select Repository File or External File, as appropriate.

6.  Enter all necessary information in the available text boxes.

7.  Click OK.

The new document appears in the list.
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8.  To edit file information for an existing document, select the document, click Edit and 
repeat Steps 4-7.

9.  When finished, click Approve.

Relationships Tab

1.  Click the Relationships tab.

2.  Click the Add button.
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The Add Relationship pop-up opens.

3.  Use the Search or List All Active buttons to display assets in the Asset section of 
the pop-up.

4.  Select an asset from the list.

5.  Use the Relationship Type drop-down to select the appropriate relationship between 
the two assets.
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Note: If necessary, click  to reverse the relationship.

6.  Click OK when finished.

7.  Repeat as necessary to add other asset relationships.

8.  When finished, click Approve.

See the BEA AquaLogic Enterprise Repository Administration Guide for information on 
configuring relationships.

Completing the Tab Approval Process

While certain tabs are common to all asset types, the specific Asset Editor tabs for any 
asset are determined by the configuration of the Type template to which the asset is 
assigned on submission. Similarly, the metadata elements that appear on any tab are also 
determined by the Type configuration. While the specific tabs and elements may vary from 
Type to Type, the approval process for each tab involves the entry and/or review of the 
information in each element.

Administration Tab

Every asset in BEA AquaLogic Enterprise Repository has an Administration tab. Use the 
Administration tab to:

●     Track the asset Created, Submitted, Accepted workflow.

●     Assign users to review and approve information on the other tabs.

●     Change the asset's status:
❍     Active
❍     Inactive
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❍     Retired
❍     Deleted

●     View asset notes and reviews.

●     Complete the registration process by clicking the Register button.
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A registered asset can include unapproved tabs.

Completing the Registration Process

Saving Changes

1.  Click Save in the File menu.

Audit Log, Reviews, and Notes

Audit Log Entries

When an Asset is updated, a record of the User, date and action appears in the Audit Log. 
Logged changes include:

1.  Asset Creation

2.  Asset Update
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3.  Changes in an Asset's Registration Status

4.  Changes in an Asset's Active Status

The log entry is added to the list in the Logs section on the asset's Administration 
tab. (It may be necessary to click the Refresh button in the Logs section.)

Adding a Note to the Asset

1.  Click Add Note in the File menu.

The Add a Note for... pop-up opens.

2.  Enter the appropriate information in the text box.

3.  Click OK.

The note is added to the list in the Logs section on the asset's Administration tab. (It 
may be necessary to click the Refresh button in the Logs section.)

See the BEA AquaLogic Enterprise Repository Administration Guide for more information 
on using the Asset Editor.

http://docwiki.flashline.com/index.php/ALER26_Registration_Process (17 of 17)11/1/2006 11:06:04 AM

© 2000-2006 BEA Systems, Inc. All rights reserved. Page 21 of 91



DocWiki - ALER26_Asset_Editor

Using the Asset Editor

Overview

The Asset Editor is used to administer assets and to configure assets and types. 
Categories, relationships, rejection reasons, repositories, and vendors are also configured 
within the Asset Editor.

The specifics of configuration depend on your organization's guidelines, and may differ 
slightly from the options discussed here.

Launching the Asset Editor

This procedure is performed on the BEA AquaLogic Enterprise Repository Assets screen.

1.  Click Edit/Manage Assets.

The Asset Editor opens.
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Configuring System Options

Six system options can be configured from the Actions menu in the Asset Editor.

Configure Acceptable Value Lists

Defines/identifies the single- and multiple-selection lists used as metadata elements in asset 
displays.

This procedure is performed in the Asset Editor.

1.  Select Configure Acceptable Value Lists from the Actions menu.
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The Configure Acceptable Value Lists pop-up opens.

2.  Click Add

The Add Acceptable Value List pop-up opens.

3.  Enter an appropriate name in the List Name text box.

http://docwiki.flashline.com/index.php/ALER26_Asset_Editor (3 of 22)11/1/2006 11:06:19 AM

© 2000-2006 BEA Systems, Inc. All rights reserved. Page 24 of 91



DocWiki - ALER26_Asset_Editor

4.  Enter an appropriate list item name in the text box next to the Add button.

5.  Click Add.

6.  Repeat Steps 4 & 5 as necessary to add additional list items.

7.  When finished, click OK.

The new list appears in the Configure Acceptable Value Lists pop-up.

8.  To edit any Acceptable Value List, select the list from the Configure Acceptable 
Value Lists pop-up.

9.  Click Edit.

The Edit Acceptable Value List pop-up opens. (Same form as the Add Acceptable 
Value List pop-up.)

10.  Make changes as necessary.

11.  Click OK.
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Configure Categorizations

Categorizations determine how assets are organized and viewed. They can also be applied 
in a similar fashion to projects.

This procedure is performed in the Asset Editor.

1.  Select Configure Categorizations from the Actions menu.

The Configure Categorizations pop-up opens.

2.  Click Add.

The Add Categorizations pop-up opens.

3.  Enter the appropriate information in each of the text boxes.
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4.  Make the appropriate selection in the Mutually exclusive assignment? checkbox.

5.  Make the appropriate selection in the Assignable to projects? checkbox.

6.  Click Add to add sub-categorizations.

7.  When finished, click OK.

The new categorization appears in the Configure Categorizations pop-up.

8.  To edit any Categorization, locate it in the list in the Configure Categorizations pop-
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up.

9.  Click Edit.

The Edit Categorization pop-up opens. (Same form as the Add Categorizations 
pop-up.)

10.  Make changes as necessary.

11.  Click OK.

Configure Relationships

Relationships define the connection, interaction, or interdependence between assets. If so 
configured, assets subject to a specific relationship to an asset that has been selected for 
use (that is, the Use - Download button has been clicked) may also be downloaded.

This procedure is performed in the Asset Editor.

1.  Select Configure Relationships from the Actions menu.

The Configure Relationships pop-up opens.
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2.  Click Add.

The Add Relationships pop-up opens.

3.  Enter the appropriate information in each of the text boxes.

4.  Make the appropriate selection in the Direction drop-down.
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The selected direction affects the information displayed in the Source Asset and 
Target Asset text boxes. For example, in a two-way relationship, the target and 
source are interdependent, whereas Two-way -- order matters can be used to 
describe the relationship between sequential versions of an asset, i.e., the 
relationship between Asset v0.90 and Asset v1.0.

5.  Make the appropriate selection in the Make target assets available for download 
with the source asset checkbox.

6.  When finished, click OK.

7.  To edit any Relationship, locate it in the list in the Configure Relationships pop-up.

8.  Click Edit.

The Edit Relationships pop-up opens. (Same form as the Add Relationship pop-
up.)

9.  Make changes as necessary.

10.  Click OK.

Configure Rejection Reasons

Determines the selection of Rejection Reasons available to users who reject previously 
used/downloaded assets. Rejection Reasons provide valuable local community feedback 
on assets.

This procedure is performed in the Asset Editor.

1.  Select Configure Rejection Reasons from the Actions menu.

The Configure Rejection Reasons pop-up opens.
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2.  Click Add.

The Edit Reject Reasons pop-up opens.

3.  Enter the appropriate text in the Rejection Reason text box.

4.  When finished, click OK.

5.  To edit any Reject Reason, locate it in the list in the Configure Rejection Reasons 
pop-up.

6.  Click Edit.

The Edit Reject Reasons pop-up opens.
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7.  Make changes as necessary.

8.  Click OK.

Configure Repository Hosts

Determines where the files relevant to assets in the Repository are stored.

This procedure is performed in the Asset Editor.

1.  Select Configure Repository Hosts from the Actions menu.

The Configure Repository Hosts pop-up opens.

2.  Click Add.

The Create a new Repository Host pop-up opens.
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3.  Enter a name for the repository.

4.  In the Type list, select a type for the repository.

❍     Default Types:
■     FTP

■     Accesses files on an FTP server

■     HTTP
■     Accesses files on a Web server

■     HTTPS
■     Accesses files on a secure Web server

■     UNC
■     Accesses files using a Windows or Samba share

■     Raw URI
■     Access files via a raw URI.

❍     Depending on the integration options included in your installation of BEA 
AquaLogic Enterprise Repository, one or more of the following types may be 
available: 
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■     PVCS
■     Accesses the PVCS source control management system

■     ChangeMan DS
■     Accesses the ChangeMan DS source control management system

■     ClearCase
■     Accesses the ClearCase source control management system

■     CVS
■     Accesses the CVS source control management system (requires 

ViewCVS or similar product)

■     FileStores
■     Accesses the ClearCase or other SCM control management 

system

■     ClearQuest
■     Accesses the ClearQuest defect tracking system

5.  Enter a hostname and path for the server.

6.  Optional: Enter a username and password.

Exercising this option enables automatic login.

7.  When finished, click OK.

8.  To edit any Repository Host, locate it in the list in the Configure Repository Hosts 
pop-up.

9.  Click Edit.

The Edit Repository Host pop-up opens. (Same form as the Create a new 
Repository Host pop-up.)

10.  Make changes as necessary.

11.  Click OK.
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Configure Vendors

Defines/identifies vendors providing assets to the repository.

This procedure is performed in the Asset Editor.

1.  Select Configure Vendors from the Actions menu.

The Configure Vendors pop-up opens.

2.  Click Add.

The Add Vendor Name pop-up opens.

http://docwiki.flashline.com/index.php/ALER26_Asset_Editor (14 of 22)11/1/2006 11:06:19 AM

© 2000-2006 BEA Systems, Inc. All rights reserved. Page 35 of 91



DocWiki - ALER26_Asset_Editor

3.  Enter the appropriate information in the Name text box.

4.  When finished, click OK.

5.  To edit any Vendor, locate it in the list in the Configure Vendors pop-up.

6.  Click Edit.

The Edit Vendor Name pop-up opens. (Same form as the Add Vendor Name pop-
up.)

7.  Make changes as necessary.

8.  Click OK.

Asset/Compliance Template Migration

Overview

Migration refers to the transfer of metadata and files from one asset or compliance template 
to another, usually of the same type. Since it is easier to edit metadata than to recreate it, 
this function allows users to quickly create different versions of assets or compliance 
templates. For example, in order to create JavaComponent v1.0, one would migrate the 
metadata and files from JavaComponent v0.90, then make the necessary changes in the 
metadata for the v1.0 asset. When migrating an asset the new asset must have a different 
name, version number, or both. Migration does NOT remove the original asset from the BEA 
AquaLogic Enterprise Repository.

It is also possible to migrate an asset or compliance template to a different type. However 
differing metadata elements will not transfer. For example, if the originating asset type uses 
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a table on one of its tabs and is migrated to an asset type that does not have the same table 
element, the table and its metadata will not migrate. The table metadata element would have 
to be created in the new asset type.

Migrating an Asset/Compliance Template/Policy

This procedure is performed in the Asset Editor.

1.  Use Search or browse the Asset Editor file tree to locate the source asset or 
compliance template to be migrated.

2.  Select Copy/Migrate in the File menu.

The Copy/Migrate pop-up opens
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3.  Enter the appropriate information in the Name and Version text boxes.

4.  Select the destination Type (the type to which the source artifact is to be migrated) in 
the Type drop-down.

Migrating assets between dissimilar types will affect the display of asset information in 
the asset detail and in the Asset Editor.

5.  When finished, click OK.

The migrated asset appears in the Asset Editor.
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6.  Click the new asset's Administration tab.
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7.  Register the new asset or assign it to another user for registration.

8.  Save the asset.
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Asset Registration Status

The registrar may assign a status to the asset using the Administration tab in the Asset 
Editor.

●     Active
❍     The status assigned to any asset that is available for use.

●     Inactive
❍     The status assigned to any asset in the repository but unavailable for general 

use. An inactive asset can be re-activated or retired. Inactive assets show up in 
a search, but cannot be selected for use (the Use - Download button is not 
displayed).

●     Retired
❍     The status assigned to any asset in the repository that is retired from general 

use. A retired asset can be re-activated or made inactive. Retired assets 
cannot be selected for use (the Use - Download button is not displayed), nor 
will they show up in a search; however, they will still be available as related 
assets to active or inactive assets in the repository.

●     Deleted
❍     The status assigned to any asset that is removed from the repository. Deleted 

assets cannot be recovered or have their status reassigned.

Assigning or Changing an Asset's Status

This procedure is performed in the Asset Editor.

1.  Use Search or browse the Asset Editor file tree to locate the source asset or 
compliance template to be migrated.
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2.  Click the Administration tab

3.  In the Status drop-down list, select the status to be assigned to the asset.

4.  Save the asset.

Note: Depending on the assigned status, the asset may disappear from the tree (Deleted) 
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Adding Files to an Asset

This procedure is performed in the BEA AquaLogic Enterprise Repository Asset Editor.

1.  Use Search or other means to locate the asset to which a file will be added.

2.  Locate the File Information element on the Overview tab.

3.  Click the Add button.

The Edit pop-up opens.

4.  Fill in the Name and Description text boxes.

5.  Click the Edit button (next to the URL field).

The Edit URL pop-up opens.
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6.  Use the radio buttons to select the source of the file to be added.

❍     Repository File

1.  Select an item from the Host drop-down. (Configuration determines 
available selections.)

2.  As necessary:

■     Enter the appropriate additionalPathStructure/fileName 
in the Path text box, or...
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■     Click the Browse button to browse to the file to be added.

❍     External File

1.  Enter the file URL in the URL text box

2.  Click Test to verify that the URL is valid.

7.  If necessary, a supplementary text file may be created and added to the file:

1.  Click the Text File radio button.

2.  Select the type of text file from the Type drop-down.

3.  Enter text as necessary in the File text box.

8.  When finished, click OK to close the Edit URL pop-up.

9.  Click OK to close the Edit pop-up.

The added file will now appear in the list in the File Information element.
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Working With UDDI Registries

Overview

The Asset Editor also enables access to UDDI from the tree. UDDI (Universal Description, 
Discovery and Integration) enables organizations to quickly, easily, and dynamically find 
assets on the Web and use them in their own initiatives. The UDDI Registry implements the 
UDDI specification and is the access point for external searches of the Internet or your 
organization's internal UDDI directory.

Access to and from the UDDI Registry is performed using SOAP (Simple Object Access 
Protocol); other protocols may be used.

The UDDI Registry enables the addition of new Web services or other assets that your 
organization may find valuable over the course of time. Importing an item through the UDDI 
Registry places it in the Queued folder for the selected asset type; subsequently, the item or 
service undergoes the same submission and approval process as any internal item or 
service.

The information registered in the UDDI Registry includes:

●     Business entity
❍     The business entity represents information about a business to which a service 

or asset belongs. The entity contains unique identifiers, the business name, a 
description of the business, basic contact information, and a URL that points to 
more information about the business.

●     Service entity
❍     The service entity is a list of the business services offered by the business 

entity. Each entry contains a description of the service, categories that describe 
the service, and pointers to reference information related to the service.
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●     Specification pointers
❍     Specification pointers are a list of binding templates that point to specifications 

about the service, and associate the service with a service type.

●     Service types
❍     Service types are defined by tModels, which specify information such as the 

tModel name, the name of the organization that published it, a list of categories 
that describe the service type, and pointers to technical specifications for the 
service type.

Access to the UDDI feature depends on the options purchased or included with your specific 
instance of BEA AquaLogic Enterprise Repository.

Using the UDDI Registry

Use the UDDI Registry to search for services and then import them into BEA AquaLogic 
Enterprise Repository. (The UDDI Registry option must be enabled.)

This procedure is performed in the Asset Editor.

1.  Open the UDDI Registries folder in the tree.

2.  Select a UDDI registry.

The selected UDDI registry opens in the Asset Editor.
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3.  Enter a search term in the Search text box.

4.  Click the Search button.

5.  Select a service from the list of results.

6.  Click Import Service.

7.  In the Import Service dialog box, enter a name and version number for the service, 
and select an asset type.
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8.  When finished, click OK.

The service or item appears in the tree, in the Submitted queue, under the assigned 
asset type.

9.  Proceed with asset registration.
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The Producing Projects Feature

Overview

The Producing Projects feature tracks and reports on assets that were produced by 
projects. This level of traceability is essential to understanding and evaluating the return on 
investment in individual projects and in the project portfolio. The Producing Projects 
element appears in the detail display of assets.

This feature is standard in the base BEA AquaLogic Enterprise Repository product.

Adding a Producing Project to an Asset

This procedure is performed in the Asset Editor.

1.  Select the asset to which the Producing Project is to be added.

2.  Click the Add button in the Producing Projects section on the Overview tab.

The Add Producing Projects pop-up opens.

3.  Click the List All button in the Add Producing Projects pop-up to display a list of 
available projects in the left window.
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Projects can also be located by using the Search function in the Add Producing 
Projects pop-up.

4.  Select the appropriate project and use the arrow button (>>) to move the project to the 
window on the right.

5.  Click OK to close the Add Producing Projects pop-up.

The selected project is listed in the Producing Projects section on the Overview tab.

6.  Save the asset and exit the Asset Editor.

The selected project now appears in the Producing Project(s) section in the asset 
detail in the Assets section of BEA AquaLogic Enterprise Repository.
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Using the Type Manager

Overview

Understanding Types

Each artifact in BEA AquaLogic Enterprise Repository falls under one of three general 
headings:

●     Asset
●     Compliance Template
●     Policy

Each of these headings is represented by a variety of Types:

●     Asset Types
●     Compliance Template Types
●     Policy Types

These Types are patterns, various instances of which are created to accomodate the 
diverse artifacts that can be managed within BEA AquaLogic Enterprise Repository. For 
example:

●     Application is an instance of an Asset Type.

●     Project Profile is an instance of a Compliance Template Type.

●     Regulatory Compliance Policy is an instance of a Policy Type.
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Types determine both the display of information for, and the taxonomy of, all of the artifacts 
(assets/compliance templates/policies) in BEA AquaLogic Enterprise Repository. BEA 
AquaLogic Enterprise Repository ships with several Types. These may be modified, or new 
types can be created using the Type Manager.

The Type Manager controls the organization and display of information for each artifact as it 
appears in the Asset Editor and in the Asset Detail.

Launching the Type Manager

This procedure is performed in the Asset Editor.

1.  Select Manage Types in the Actions menu.

The Type Manager opens.
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2.  Select an asset type or compliance template from the tree to view/edit its 
configuration.

Type Manager Views

Each type has an Editor and a Viewer.

Information relevant to the configuration of the Editor and the Viewer views for each type is 
stored in XML files in the database. The Type Manager loads the XML files into a GUI, 
which enables the creation, modification, and deletion of types. After the type is saved, the 
data is assembled in XML and loaded into the database.

The Editor

The Editor controls the organization and display of information for assets/compliance 
templates of the particular type as they appear in the Asset Editor.
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The Editor display is divided into three sections:

●     General
❍     Includes the type name, the usage status selector, the type icon selector, and a 

Preview button, which displays the asset or compliance template type as seen 
via the Asset Editor.

●     Tabs
❍     Includes a list of available tabs for the type. These tabs correspond to tabs 

displayed in the Asset Editor view of an asset/compliance template. Click on 
any listed tab to display its elements in the Elements section, just below the 
Tabs section.
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●     Elements
❍     The elements of any tab listed in the Tabs section are displayed here when the 

item is clicked.

Several buttons appear to the right of the Tabs and Elements sections: 

●     Add
●     Edit
●     Remove
●     Move Up
●     Move Down

These actions may be applied to any item listed in the Tabs or Elements sections. Simply 
select the item, and then click the appropriate button.

The elements listed below are required for valid Types. They may be renamed, but cannot 
be removed from a type.

●     Name
●     Version
●     Description
●     File information
●     Notification Email
●     Keywords

The Viewer

The Viewer controls the organization and display of information for assets/compliance 
templates of the particular type as they appear in the Assets section of BEA AquaLogic 
Enterprise Repository (the general user view of asset/compliance template information).
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The Viewer display is divided into three main sections:

●     Hidden Elements
❍     Lists all elements available for display.

■     Use the Edit button (on the right) to change the configuration of any 
listed element.

■     Use the Display in Group button to assign the element to one of the two 
columns in the main asset display in BEA AquaLogic Enterprise 
Repository.

●     Groups
❍     Includes Column One and Column Two. These correspond to the two main 

columns in the main asset display in BEA AquaLogic Enterprise Repository. 
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Use the buttons on the right to configure the elements in the respective 
columns.

●     Elements
❍     Click on any item in Groups -- Column One or Groups -- Column Two to 

display the respective item's elements in the Elements section. Use the buttons 
on the right to configure these elements.

Use Caution! Changes made to Types affect the display of all assets assigned to that 
type.

Creating a New Type

Caution: Adding an asset/compliance template type constitutes a permanent change 
to the BEA AquaLogic Enterprise Repository system.

In order to preserve database integrity, only Types to which no assets are currently 
associated may be deleted.

Note: This action may alter reuse measurements.

1.  Select New in the File menu.

The Create New Type pop-up opens.
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2.  Enter the appropriate information in the Type Name text box.

3.  In the Type for Defaults drop-down, select one of the existing Types as the basic 
template for the new type.

4.  Click OK.

The new Type appears in the tree.

Configuring Tabs to Support Registration Workflow

Overview

Tabs should be positioned on a Type in a logical sequence that accommodates the 
registration workflow. For example, in the Framework asset type (shipped with BEA 
AquaLogic Enterprise Repository), it is intuitive to complete the General information first. 
The Documentation and Testing tabs, being very similar, are located near each other. The 
actual registration step, the last in the workflow process, is performed on the 
Administration tab. For that reason the Administration tab is system generated and 
intentionally fixed in its position.
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Adding Workflow Tabs

1.  Select the Type to be modified.

2.  Select the Editor.

3.  Click Add in the Tabs section.
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The Tab Information pop-up opens.

4.  Enter the appropriate information in the Tab Name text box.

5.  Click OK.

The name for the new tab appears in the Tabs section list.

6.  Click Preview.
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The preview pop-up opens. The new tab is displayed.

7.  Close the Preview pop-up.

8.  Save the changes.

Change the Position of a Tab

1.  Select the Type to be modified.
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2.  Select the Editor.

3.  Select the tab to be moved.

4.  Click Move Up or Move Down, as appropriate.

Each click moves the tab one level. This example moves the selected tab from the 
bottom to the top of the list.
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5.  Click Preview.

The preview pop-up opens. Note new position of the tab.

6.  Save the changes.
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Editing Workflow Tabs

1.  Select the Type to be modified.

2.  Select the Editor.

3.  Select the tab to be edited.
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4.  Click Edit.

5.  Rename the tab.

6.  Click OK.

7.  Save the changes.

Deleting Workflow Tabs

Note: Deleting a tab deletes all data associated with the tab.

1.  Select the Type to be modified.
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2.  Select the Editor.

3.  Select the tab to be deleted.

4.  Click Remove.

A confirmation pop-up appears.
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5.  Click Yes.

The tab is deleted, and no longer appears in the tabs list or in the preview.

6.  Save the changes.

Important

All tabs may be deleted from a type, with the exception of those containing any of the 
following required elements:

●     Name
●     Version
●     Description
●     File information
●     Notification Email
●     Keywords

The system prevents the deletion of any tab containing any of these elements. In order to 
delete a tab containing any of these elements the elements must first be moved to another 
tab.

Tab Elements
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A variety of Elements can be added to tabs to accommodate the management and 
presentation of asset metadata. Some of these Elements are single-use: they are used only 
once in a type. Once assigned, single-use elements no longer appear in the list of available 
elements. The properties for each element type are listed below.

●     Text field -- contains data strings
❍     Display Name

■     Element label that appears in the Asset Editor.
❍     Required

■     If checked, the field must be populated with data before the asset is 
saved.

❍     Indexed
■     If checked, the field appears in advanced searches for that type.

❍     Maximum Length
■     A validation rule for the maximum length of data in the field; accepts 

numerical entries.

●     Numeric text field -- contains a single numeric value
❍     Display Name

■     Element label that appears in the Asset Editor.
❍     Required

■     If checked, the field must be populated with data before the asset is 
saved.

❍     Indexed
■     If checked, the field appears in advanced searches for that type.

❍     Maximum Length
■     A validation rule for the maximum length of data in the field; accepts 

numerical entries.

●     Date field -- contains a single date value
❍     Display Name

■     Element label that appears in the Asset Editor.
❍     Required

■     If checked, the field must be populated with data before the asset is 
saved.

❍     Indexed
■     If checked, the field appears in advanced searches for that type.

●     URL -- contains a string that links to a URL
❍     Display Name

■     Element label that appears in the Asset Editor.
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❍     Required
■     If checked, the field must be populated with data before the asset is 

saved.
❍     Indexed

■     If checked, the field appears in advanced searches for that type.

●     Check box -- contains a two-value checkbox that is either on or off.
❍     Display Name

■     Element label that appears in the Asset Editor.
❍     Required

■     If checked, the field must be populated with data before the asset is 
saved.

❍     Checked by Default
■     If Yes is selected, the check box is automatically checked on new assets 

of the same type.

●     Drop-down box -- contains a list of finite items
❍     Display Name

■     Element label that appears in the Asset Editor.
❍     Required

■     If checked, the field must be populated with data before the asset is 
saved.

❍     Indexed
■     If checked, the field appears in advanced searches for that type.

❍     Acceptable Values
■     List of available data that populates the drop-down list; the Configure 

button enables configuration of the values.

●     Editable list -- contains items that are either data or numerical values
❍     Display Name

■     Element label that appears in the Asset Editor.
❍     Required

■     If checked, the field must be populated with data before the asset is 
saved.

❍     Indexed
■     If checked, the field appears in advanced searches for that type.

❍     Entry Field
■     Drop-down list of alphanumeric and numeric values; the Configure 

enables configuration of either alphanumeric or numeric values.

●     Multiple selection list -- contains data from the configured list from which items can 
be selected only once

❍     Display Name
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■     Element label that appears in the Asset Editor.
❍     Required

■     If checked, the field must be populated with data before the asset is 
saved.

❍     Indexed
■     If checked, the field appears in advanced searches for that type.

❍     Acceptable Values
■     List of available data that populates the drop-down list; the Configure 

button enables configuration of new or existing values.

●     Table -- contains column and row information; columns correspond to elements, and 
rows correspond to data about the elements; available types include:

❍     Text field
❍     Numeric Text Field
❍     URL
❍     Check box
❍     Drop-down box
❍     Table

■     Group Display Name
■     Element label that appears in the Asset Editor

■     Item Display Name
■     Data entry area

■     Required
■     If checked, the field must be populated with data before the asset 

is saved.
■     Elements

■     Each element is a column of the table and follows the same rules 
as the element type.

●     Categorization -- contains data relevant to the behavior of views in the Asset Editor; 
this can be used only once per type

❍     Display Name
■     Element label that appears in the Asset Editor.

❍     Categorization Type
■     Drop-down list of various categorizations available in ALER.

●     Asset relationship -- contains data specific to the behavior of relationships; this 
element type can be used only once per type to search for and establish a 
relationship between assets

❍     Display Name
■     Element label that appears in the Asset Editor.

http://docwiki.flashline.com/index.php/ALER26_Type_Manager (20 of 28)11/1/2006 11:06:56 AM

© 2000-2006 BEA Systems, Inc. All rights reserved. Page 72 of 91



DocWiki - ALER26_Type_Manager

●     Associated files -- contains data specific to the behavior of files; adding an 
associated create a link to the file

❍     Display Name
■     Element label that appears in the Asset Editor.

●     Contact selection -- contains data specific to the behavior of contacts; this element 
can be used only once per type to enable the creation of a contact or use of an 
existing contact

❍     Display Name
■     Element label that appears in the Asset Editor.

●     Producing projects -- contains data specific to the behavior of projects that produce 
assets as well as consume assets; this element can be used only once per type to 
enable producing projects.

❍     Display Name
■     Element label that appears in the Asset Editor.

●     JAR introspection -- contains data specific to the behavior of JAR files; this element 
can be used only once per type to add a fully qualified class name to the contents of 
the element

❍     Display Name
■     Element label that appears in the Asset Editor.

●     Requirement list/coupling -- contains data specific to the behavior of requirements; 
the element enables coupling based on the data (alphanumeric) entered in the 
element

❍     Display Name
■     Element label that appears in the Asset Editor.

●     UDDI link -- contains data specific to the behavior of UDDI registries; this element 
can be used only once per type to track a UDDI Registry URL and service key in the 
Asset Editor

❍     Display Name
■     Element label that appears in the Asset Editor.

●     Vendor selection -- contains data specific to the behavior of vendors. This element 
can be used only once per type and the names correspond to the names of the 
vendors configured in the Configure Vendors option in the Asset Editor

❍     Display Name
■     Element label that appears in the Asset Editor.

●     Uploaded submission files -- contains data specific to the behavior of uploaded 
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files; this element can be used only once per type to generate data based on the 
contents of the directory named the same as the asset ID in the upload path

❍     Display Name
■     Element label that appears in the Asset Editor.

●     Forum -- contains data specific to the behavior of forums; this element can be used 
only once per type

❍     Display Name
■     Element label that appears in the Asset Editor.

●     SFID -- contains data relevant to the behavior of Automated Usage Tracking; this can 
be used only once per type

❍     Display Name
■     Element label that appears in the Asset Editor.

●     Unique Element -- contains data relevant to the behavior of Unique ID; this can be 
used only once per type

❍     Display Name
■     Element label that appears in the Asset Editor

●     Project(s) to which template is applied -- contains data relevant to the behavior of 
Compliance Templates; this can be used only once per type

❍     Display Name
■     Element label that appears in the Asset Editor

Working with Elements

Numeric Text elements contain numeric information and are often used in conjunction with 
reports (see above). The following example adds a Numeric Text element to the Overview 
tab of a Type to create a reporting field.

1.  Select the Type to be modified.
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2.  Select the Editor.

3.  Click Add in the Elements section.

The Select an Element Type to Add pop-up appears.
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4.  Select Numeric Text Field from the drop down.

5.  Click OK.

The Edit Numeric Text Field pop-up opens.

6.  Enter the appropriate information in the Display Name text box.

7.  Checking Required means that assets of this type cannot be saved (in the Asset 
Editor) until the necessary data is supplied for all fields in this element.

8.  Check Indexed to include the element fields in BEA AquaLogic Enterprise Repository 
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searches.

9.  Enter the appropriate information in the Minimum Value and Maximum Value fields. 
(See the list above for more information.)

10.  When finished, click OK.

Adding Images for Type Manager Icons

Icon Image Requirements

●     Size: 16x16 pixels
●     Format: GIF format
●     Save to: images/tree/enterprise/asset subdirectory in the host directory for 

BEA AquaLogic Enterprise Repository installation files.

1.  Locate the icons.xml file in the images/tree/enterprise/asset subdirectory.

2.  Edit icons.xml as necessary to add icon elements for the new GIF images.

3.  If it is open, close and reopen the Asset Editor.

View/select available Type icons

This procedure is performed in the Type Manager.

1.  Select a Type.
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2.  Select the Editor.

3.  Click Assign.

The Select Icon pop-up appears.
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4.  Select an icon from the drop-down list.

5.  Click OK.

6.  Save the changes.

The new icon appears next to the Type in the list in the sidebar.
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Viewing and Editing Type XML Schemas

Overview

The Type Manager includes features that allow users to view and edit the XML schemas for 
asset types and compliance templates:

●     Export Schema
❍     Displays the XML schema for the selected asset type or compliance template.
❍     Available only to users who are assigned the Admin role.
❍     Accessed via the File menu in the Type Manager.

●     XML Editor
❍     Allows editing of XML source for the Editor and Viewer displays of an asset 

type or compliance template, as seen via the Type Manager.
❍     Available to users in the Admin role, and to others, based on specific System 

Settings.
❍     Accessed via the Support menu in the Type Manager.

Configuration

●     The Export Schema viewer is available only to users assigned to the Admin role.

●     The Support menu displayed is determined by the following conditions:
❍     If the user has Admin privileges.

■     The XML Editor option will be accessible in the Support menu.

❍     If the property cmee.asseteditor.allow.manual.proxy is enabled.
■     The manual proxy configuration option will be accessible in the Support 

menu.

Using the Export Schema feature
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This procedure is performed in the Type Manager.

1.  Select Export Schema from the File menu.

The Load pop-up opens.

2.  Select a Type from the the drop-down.

3.  Click OK.

The XML schema display opens.
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The display window does not allow editing of the schema. However, the schema may 
be saved to the local file system for later use. (Click Save in the window's File menu.)

❍     The schema may also be copied/pasted into a local document to use for 
validation of Type XML documents.

Using the Type XML Editor

The XML Editor allows unvalidated modifications of the XML source for Asset Types and 
Compliance Templates.

CAUTION

Improper changes to the XML source may render an Asset Type or Compliance Template 
inoperable.
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1.  Select XML Editor from the Support menu in the Type Manager.

A warning message appears.

2.  Click OK.

A blank window opens.

3.  Select Load from the File menu in the blank window.

The Load pop-up opens.
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4.  Select the Type whose schema will be edited from the Type drop-down.

5.  Select Editor or Viewer from the XML Type drop-down. These selections refer to the 
Editor and Viewer tabs in the Type Manager.

6.  Click OK.

The selected schema opens.

7.  Edit the schema as necessary.

8.  Save the changes.
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Unique ID

Overview

Every asset submitted to AquaLogic Enterprise Repository is automatically tagged with an 
ALER-specific ID number, which is used in the organization and management of assets. 
However, in certain environments or situations it may be advantageous for an organization 
to assign an additional custom identification key to specific assets. For example, a Unique 
ID key might be used to enforce uniqueness when relating an asset to a resource or asset in 
a system external to ALER.

AquaLogic Enterprise Repository's Unique ID feature allows users with access to the Type 
Manager to add the Unique ID element to selected asset and/or compliance template types. 
Only one Unique ID element may be added per type. This Unique ID element then appears 
in the Asset Editor display of assets of the selected types.

Users with access to the Asset Editor can assign a Unique ID key to these assets/
compliance templates by adding the appropriate information in the Unique ID text box.

The uniqueness of each ID key can be enforced across the entire system, or limited to 
enforcement within a specific type. For example, when enforced across the entire system, 
no two assets, regardless of type, may be assigned the same Unique ID key. When 
enforced within a type, no two assets of the same type can be assigned the same key. 
However, the same Unique ID may be assigned multiple assets of different types. Within 
the Asset Editor, any attempt to save an asset with a Unique ID key that has already been 
assigned to another asset results in a error message.

The specific Type Manager configuration of the Unique ID element determines whether the 
element and information contained therein is visible to users in the asset detail display for 
individual assets in AquaLogic Enterprise Repository.
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Adding the Unique ID Element to a Type

This procedure is performed in the Type Manager.

Note: The properties associated with the Unique ID element must be enabled in the 
System Settings section of the Admin screen. See Properties.

1.  Select the Type to be modified.

2.  Select the tab to which the Unique ID element is to be added.

The elements assigned to that tab appear in the Elements section.
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3.  Click Add in the Elements section.

The Select an Element Type to Add pop-up opens.

4.  Select Unique Element from the drop-down.

5.  Click OK.

The Edit Unique Element pop-up appears.
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6.  Enter the appropriate information in the Display Name text box in the Edit Unique 
Element pop-up.

7.  Click OK.

The Unique ID element now appears in the Elements list.

8.  Save the changes.

Information necessary for custom reporting

Table name:

●     UniqueElementValues

Fields:

●     assetid: ID of asset (foreign key to assets.id)
●     assettypeid: ID of assettype (foreign key to assettypes.id)
●     value: Unique value (varchar 4000)
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Note: A record will appear in the uniqueelementvalues table only if the 
asset's Unique ID element (as it appears in the Asset Editor) contains a value.

Properties

Two properties are associated with the unique element:

●     cmee.unique-element.enable
❍     Enable/disable field for uniqueness.

●     cmee.unique-element.per-assettype
❍     True = uniqueness enforced within the asset type
❍     False = uniqueness enforced across the entire system.

Note: Repeatedly toggling this property from true to false may result in unexpected system 
behavior.

Sample Scenarios:

1.  cmee.unique-element.per-assettype is set to true
❍     Uniqueness is enforced within the asset type.

■     Multiple assets of different asset types can share the same Unique ID.
■     Assets of the same asset type cannot share the same Unique ID.

2.  cmee.unique-element.per-assettype is set to false
❍     Uniqueness is enforced across the system.

■     No two assets, regardless of asset type, can share the same Unique ID.
■     Prior Unique ID assigments are unaffected by this property 

change. However, attempts to save changes to assets may be 
rejected if the asset shares a Unique ID.
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Changing the Version Field Name

Modify the Search Results Pane

1.  Navigate to the WEB-INF/config/portletsets directory.

2.  Locate the cmee_asset.psml file in the WEB-INF/config/portletsets directory.

The file contains the following line: <field display-name="Version" method-
name="getVersion" method-comparator="com.flashline.util.
comparator.CaseInsensitiveStringComparator"/>

3.  Replace Version in display-name="Version" with an appropriate name.

Note: Removing the entire line removes the field display.

Modify the Asset Detail Pane

This procedure is performed in the Type Manager.

1.  Open the Type to be modified.

2.  Click the Editor tab.

3.  Select the Version field (appears in the Overview section in default Types).

4.  Click the Edit button.

5.  Rename the field.

6.  Click OK.

7.  Save changes to the Type.
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